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Shareware Notes
This means you may copy the main program and help documentation on to as many 
machines as you like, and distribute it to as many people as you like, free of charge. 
However if you like the software, and use it often, then you are encouraged to register with 
the author. 
 



Overview
Micawber is aimed at making the job of accounting for expenses at home easy. 
 
This is done by storing accounts of money transactions in the form of payments and receipts
to produce an overall balance. 
 
Once account entries have been entered into Micawber, the account can be examined in a 
large range of ways, including sorting and ordering of entries, formatting of entries, and 
graphs. 
 
Related Topics 
Using Micawber 
The Menus 
 



Using Micawber
To get started with Micawber, create yourself a directory in which you would like to store all 
your account details in. 
 
In Micawber then set the Base Directory to this directory using the Base Directory option on 
the File menu. 
 
Now create yourself some categories using the Edit Categories option on the File menu. 
 
Once you have done this, you can create the initial month of your first account using the 
New Account option on the File menu. 
 
You can then enter account entries into this month. 
 
When you are ready to add following months you will need to load up at least one existing 
account month using the Load Month option on the FIle menu followed by using the New 
Month option on the File menu. 
 
With your account information entered, you can display it in various ways with the View 
Mode and look at it in a number of different ways with the options on the Account Menu. 
 
Related Topics 
Overview 
The Menus 
 



The Menus
Please select the menu you would like more information on: 
 

File 
Edit 
Account 
Display 
Options 
Window 

 



Registering Micawber
Micawber is declared SHAREWARE software. 
 
Cost of Registration 
It only costs 12 pounds (UK Sterling) to register Micawber. 
 
Benefits of Registration 
Once registered, your personal unlock code is stored in a file in your Micawber working 
directory so that it can be automatically entered for you every time the program loads, 
bringing the following benefits: 
1) No shareware reminder screens as the program loads and unloads. 
2) The ability to load more than 3 account months for editing at a time. Registerered users 

can have up to 20 loaded. 
 
NOT Crippleware 
Micawber is not crippleware, in that if you do not register Micawber immediately it will still 
work fully. 
 
So Why Register then? 
Well, there are several reasons: 
1) Peace of mind. You will be pleased to know that you have encouraged a single 

programmer software development outfit (that's me!!) to continue producing innovative 
and fun software in the future. 

2) Life Membership. Your Unlock code will work with ALL future versions of Micawber and 
that's guaranteed. This means that even if the registration fee is put up in the future, or I
start disabling more options on future shareware versions to encourage registration, you 
will be already registered. 

3) You will recieve information on other Moose Productions. 
 
Still Unsure? 
Go out and look at the prices of other accounting packages!! 
 
Let's Go Then! 
You can either use the automatic Registration Form if you have a printer or put together a 
manual registration. 
 
Once you have your unlock code, select Register NOW from the Help menu to register the 
program. 
 
Contact the author for more information. 
 



Contacting the Author
The author of Moose Productions software can be contacted by letter at:    

Quintin Willison    
Moose Productions    
The Old Rectory    
Norfolk    
NR16 1RW    
UK    

    
or by Electronic Mail at:    

Q.D.F.Willison@herts.ac.uk    
 
or by telephone on: 

UK: (0378) 011 839 
(you do not need to insert the PhoneDay 1 before the 378 as this is a mobile number) 

    
I will be pleased to hear from anybody who is using the software, not only in order to get an 
idea of how widely it is being used, but also to obtain suggestions and bug reports. 
 
I am currently at university,    so the E-mail address above should be valid until about mid 
1997, and will only be likely to get a response within normal term times. 
 



Revision History
Micawber uses a standard Version Numbering Scheme. 
 
v.1.00 - 16 April 1996 

Original Version. 
 



Version 1.00 Release Notes
Original Version. 
 
 



Version Numbering Scheme
Moose Productions uses a 3 digit version numbering scheme of the form: 

<major> . <minor> <fix> 
A change in the <fix> version number indicates that changes to this version from it's 
previous version were only involved with fixing bugs, performance tweaking and small 
adjustments. 
A change in the <minor> version number indicates that something slightly more important 
has been added to the program, like some extra features. Bug fixes and the like may also 
have been implemented. 
A change in the <major> version number indicates a change to the program fundamentally 
which adds a large bit of extra functionality which is not necessarily specific to any one 
feature. Additional methods and bug fixes may also have been implemented. 
 



Transaction
A transaction is the receiving or handing over of money in a bank account. 
 
If I withdraw 10 pounds from a cash machine, then I have had a transaction with the bank, 
whereby I have received 10 pounds into my hands and my bank account has made a 
payment of 10 pounds. 
 
If my work salary for the month is payed into my account then my employer has had a 
transaction with my bank, whereby they have payed money to the bank and my bank 
account has received money. 
 



Account
An account records money transactions, keeping a record of how much money is available in
the form of a balance. 
 
An account can be real, in the form of a bank current account, where that money is instantly 
accessible from my bank, or it can be in the form of a simple record. For example if a friend 
keeps borrowing money from me, then I might create a Micawber account which records how
much money I owe the friend (account in thered) or they owe me (account in the black). 
 
Account data is only editable on a monthly basis. This means that a seperate window has to 
be opened to edit data for every account months. 
 



Payment
A payment in an account means that money has been spent from the account to decrease 
it's balance. 
 



Receipt
A receipt in an account means that money has gone into the account to increase it's 
balance. 
 



Balance
The balance of an account is how much money the account has in it at any one time. 
 
Opening and Closing Balances 
The opening balance is how much the account has in it at the beginning of the month. 
The closing balance is how much the account ends up with in it at the end of the accounting 
month. 
 



Red
For an account to be in the red, it must have more than zero for it's balance. 
 



Black
For an account to be in the black it is overdrawn (balance is less than zero). 
 



Overdrawn
For an account to be overdrawn, it has less than zero in it's balance. 
 



File Menu
Please select the option you would like more information on: 
 

New Account... 
Delete Account 

 
New Month... 
Load Month... 
Close Month 
Export Entries... 
Import Entries... 

 
Edit Categories... 
Base Directory... 

 
Exit 

 



Edit Menu
Please select the option you would like more information on: 
 

Cut Entry 
Copy Entry 
Paste Entry 

Insert Above Current Entry 
Overwrite Current Entry 
Insert Below Current Entry 

Delete Entry 
 

Insert New Entry Above 
Insert New Entry Below 

 



Account Menu
Please select the option you would like more information on: 
 

Analysis 
Category Distribution 

Payments... 
Receipts... 

Report 
Statement... 

 
Change Opening Balance... 
Information... 

 



Display Menu
Please select the option you would like more information on: 
 

Edit 
View 

 
View Options... 

 



Options Menu
Please select the option you would like more information on: 
 

Automatic Categories 
Load in View Display Mode 

 
Save Now 
Save on Exit 

 



Window Menu
Please select the option you would like more information on: 
 

Cascade 
Tile Vertical 
Tile Horizontal 
Arrange Icons 

 



File: New Account...
Initialises a new account. 
This is done by creating the first account month for the account: 
 
Account Name 
This is a freeform text area for you to give a name for your account. It is important to be 
descriptive here, as this will be the only way of you recognising which account it is later on. 
You can have names with a maximum of 40 characters. 
For example you might enter: 

Lloyds Current Account 
 
Opening Balance 
This is the amount of money that the account month you are going to enter first for this 
account has in it. 
 
Account Info 
This is a space for you to enter additional information about the account. Like the account 
name this is freeform text, but unlike the account name you can enter quite a lot more text 
here (100 characters). 
For example you might enter additional account details like: 

Sort Code: 02-01-03    Acc. No.: 5567722 
This text get's printed underneath the account name on all reports generated by Micawber. 
 
Opening Month 
This is the first month you are going to enter for the account. Click on the Change button to 
select the month you want. 
 
 
Creating New Accounts 
To create a new account, you enter the earliest month for that account you have with New 
Account and then use New Month for following months in order. It is best to do it this way as 
you will then only need to enter one opening balance, for the first month, and then the 
following month opening balances will be automatically worked out for you from previous 
month closing balances when you create the new months. 
 



File: Delete Account
This deletes all files related to the account in the current account month window. This means
that not only the loaded account month is deleted, but all months - effectively elliminating 
the account!! 
 
You will have to close down all other months for the account in Micawber before trying this 
option. 
 



File: New Month...
Creates additional account months for the currently opened account. 
Displays the Select Month window. 
 
Use this to add extra statements worth of account entry data to an account. You will need to 
load up and select the edit window for one month of the account before using this method. 
 



File: Load Month...
Loads an account month from disk for editing or viewing in a new window (Micawber is an 
MDI application). 
 
To change the month, click on the Change button and you will be presented with the Select 
Month window. 
 



File: Close Month
Select to finish editing the current account month window, saving all the data and then 
closing the window. 
 



File: Edit Categories...
Allows you to change the Micawber Categories database. 
Categories can only be changed when no accounts are open. For this reason, if you select 
this option without having closed all open account months down then you will recieve an 
error. 
 
Displays the Edit Categories window. 
 
The Categories database is stored in the current base directory and is only relevant to 
accounts in that directory. 
 



File: Base Directory...
Select in order to change the current base directory for storage and retrieval of accounts 
data. 
 



File: Exit
Bye Bye! 
 



Edit: Cut Entry
Copies the currently selected account entry to the clipboard and then deletes it from the 
account month. 
 



Edit: Copy Entry
Copies the currently selected account entry to the clipboard. 
 



Edit: Paste Entry: Insert Above Current Entry
Pastes the account entry in the clipboard above the currently selected account entry. 
 



Edit: Paste Entry: Overwrite Current Entry
Pastes the account entry in the clipboard over the currently selected account entry, 
replacing it. 
 



Edit: Paste Entry: Insert Below Current Entry
Pastes the account entry in the clipboard below the currently selected account entry. 
 



Edit: Delete Entry
Deletes the currently selected account entry. 
 



Edit: Insert New Entry Above
Inserts a blank account entry above the currently selected account entry. 
 



Edit: Insert New Entry Below
Inserts a blank account entry below the currently selected account entry. 
 



Account: Analysis: Category Distribution: Payments
Displays a pie chart showing distribution of payments for the current account month. 
 



Account: Analysis: Category Distribution: Receipts
Displays a pie chart showing distribution of receipts for the current account month. 
 



Account: Analysis: Monthly Payments/Receipts
Displays a bar chart of payments against receipts by account month for the 18 months 
preceeding the currently loaded account month. 
Any months not existing will just not display on the bar chart. This means this graph is useful
even when you do not have a full 18 months of data in Micawber. 
 



Account: Report: Statement
Print a copy of the current account month. 
 
Statement Options 
Displays the View Settings window in order for you to select the columns to print, the order 
which to print them in and any filtering options. 
 
Page Setup 
Displays the Page Setup window in order for you to setup the margins for the printed 
statement. 
 



Account: Change Opening Balance
Allows you to change the opening balance for this account month. 
 



Display: Edit
Changes the account month into Edit Mode. 
 



Display: View
Changes the account month into View Mode. 
 



Display: View Options...
Change the way the account displays in view mode. 
If no accounts are loaded then this changes global view settings (e.g. those for new 
accounts). 
 
Displays the View Settings window. 
 



Options: Automatic Categories
This option instructs Micawber to look at the Particulars for account entries as you enter 
them and to look for keywords from your category database in order to try and work out 
what category the entry belongs to. 
Pressing the RETURN or ENTER key triggers this check to go off. It is therefore recommened 
to enter your account entries not using TAB. 
Existing categories will not get replaced. 
 



Options: Load in View Display Mode
This option instructs Micawber to load all accounts in View Mode automatically. 
 



Options: Save Now
Saves all settings now. This option may be used if you do not want Micawber to save on exit 
but you want to save the current settings. 
 



Options: Save on Exit
Selecting this option instructs Micawber to save all settings whenever a Micawber session is 
ended (e.g. you exit or close the program). 
 



Window: Cascade
Cascades all Micawber account windows one on top of the other from the top left corner of 
the Micawber main window. 
 



Window: Tile Vertical
Arranges all Micawber account windows neatly within the MIcawber main window in order to 
maximise their viewing area vertically. 
 



Window: Tile Horizontal
Arranges all Micawber account windows neatly within the MIcawber main window in order to 
maximise their viewing area horizontally. 
 



Window: Arrange Icons
Arranges all iconised Micawber account windows neatly within the Micawber main window. 
 



Base Directory
Micawber allows you to set up areas for seperating accounting activities in to. These are 
based around directories on your hard disk or storage network, known as base directories. 
 
What the Base Directories store 
Each base directory has it's own database of categories, and any one account must be 
totally stored in any one base directory. 
 
When Micawber creates and saves account months it stores all the data in the current base 
directory. This inlcudes configuration options for the accounts (like view options). 
 
Example 
If both my flatmates and I all use the computer for entering accounts information into, then I
may create a number of directories on the hard disk like this: 

c:\micawber\quintin 
c:\micawber\tom 
c:\micawber\matt 

and then, for example, when Tom wants to do anything with his accounts his first operation, 
once he's loaded Micawber, is to simply change the base directory to      c:\micawber\tom      
by using the Base Directory option on the file menu. 
 



Account Month
Micawber stores data for each month of an account in a different file. These files are known 
as account months. This system means that Micawber is very fast to deal with data, as only 
one month of data is dealt with at a time. Also, summary data is saved with each month to 
make monthly analysis easier. 
 



File: Export Entries...
Export account entries to a CSV file. 
 
Select a filename to save under. The normal filename extension to use for these files is CSV. 
 



File: Import Entries
Import account entries from a CSV file. 
 
Select a file to import. 
 
You will then be presented with the Import Entries window. 
 



Category
A category is a way to assign your account entries into groups of type of transaction. 
For each Micawber base directory you have on your system, a category database file is 
stored. This means that all the accounts in that directory will use the same categories. 
Use the Edit Categories option on the File menu to edit categories. 
 



View Settings
Click on any are of the window you would like more information on: 
 

 
 



Display Columns
Check the boxes next to the columns you want to be displayed, and make sure that the 
columns you do not want displayed are not checked. 
 



Sort By
Select the column by which you would like to sort the displayed account entries. 
For example, sorting by day would be asking the computer to display earliest entries first 
followed by later entries, wheras sorting by Particulars will display entries alphabetically by 
whatever text is in the particulars column. 
 



Filter
Check the boxes next to columns you would like to filter with. 
You will need to enter filter settings next to this box. 
For example, if I want to only display account entries made between days 10 and 20 of this 
month, then I would check the filter box next to Day and type 10 into the first of the 
between boxes and 20 into the second. 
 



Between (Day)
Enter the lowest day you would like to display in the first box and the highest day you would 
like to display in the second box. 
For example, if I wanted to display account entries between days 10 and 20 of this month 
then I could enter 10 into the first box and 20 into the second. 
Not entering anything in one of the boxes puts no limits on that end of the scale. 
For example, if I wanted to display account entries below day 25 of the month then I could 
just enter 25 into the second box, whereas if I wanted to display account entries above day 
11 of the month I could just enter 11 into the first box. 
 



Substring (Particulars)
Enter a piece of text which must be contained within the particulars text of an account entry 
in order for the filter to succeed. 
For example, if I only want to display entries with "ASDA" in them, then I could enter "ASDA" 
into this space. I would then get entries back like "ASDA SUPERSTORES", "THE ASDA CO." 
and "MASDA MOTORS", because all of these entries contain the text "ASDA". 
 



Between (Amount)
Enter the lowest amount you would like to display in the first box and the highest amount 
you would like to display in the second box. 
For example, if I wanted to display account entries for amounts over -20 and under 30    then
I could enter -20 into the first box and 30 into the second. 
Not entering anything in one of the boxes puts no limits on that end of the scale. 
For example, if I wanted to display payments from my account    then I could just enter 0 into
the second box, whereas if I wanted to display account receipts over 10 then I could just 
enter 10 into the second box. 
 



Category List
This displays the categories for which the filter will succeed. 
Click on the button to the right of this box to change this. 
 



Category List
Click on this button to change the categories for which the filter will succeed. 
 



Matches
Select this option next to columns with filters for which you would like the filter to operate 
normally. 
i.e. when the filter succeeds the entry gets displayed. 
 



Exceptions
Select this option next to columns with filters for which you would like the filter to operate in 
an inverse manner. 
i.e. entries only get displayed when the filter fails. 
 



1 column: +ve/-ve
Select this option to display account entries with the standard amount format and a simple 
plus or minus sign depending on whether the entry is a payment or a receipt. 
 



Amount Format
All amounts in Micawber are display with the standard format of comma seperated 
thousands and 2 decimal places. 
e.g. 

8899922.347 
displays as: 

8,899,922.35 
 



1 column: DR/CR
Select this option to display amounts with the standard amount format but to display a CR 
for receipts instead of a plus symbol and a DR for payments instead of a minus symbol. 
 



2 columns: Payments/Receipts
Select this option to display amounts in two columns formatted with the standard amount 
format. 
No plus/minus or CR/DR symbols need be displayed with this option. 
This is how a bank statement would tend to display your account transactions. 
 



-ve/+ve
Select this option to display balance entries with the standard amount format and a plus 
sign to signify the account is in credit and a minus symbol to indicate overdrawn. 
 



OD
Select this option to display balance entries with the standard amount format and no plus or 
minus signs. Instead OD is printed next to the balance if the account is overdrawn.    
 



End of Day Only
This option only displays balances if they are next to the last entry of the day. 
This is how your bank statement is most likely to display your account transactions. 
 



Import Entries
Click on any are of the window you would like more information on: 
 

 
 



Day
Select the column from the imported file which you would like to be the source for day 
information on imported entries. 
 



Particulars
Select the column from the imported file which you would like to be the source for 
particulars information on imported entries. 
 



Category
Select the column from the imported file which you would like to be the source for category 
information on imported entries. 
 



Add New Categories to Database
Check this option if you would like Micawber to ensure that all categories in the imported file
are imported. 
Micawber does this by adding categories it cannot find in your category database to the 
database automatically as the import progresses. 
 



Amount
Select the column from the imported file which you would like to be the source for amount 
information on imported entries. 
 



CSV
Comma Seperated Values 
 
File format used for transferring data between spreadsheet and database applications. 
Micawber will both export and import these files. 
 



Edit Mode
This mode for account windows allows you to edit the account entries. 
 



View Mode
This mode for account windows allows you to view the account entries neatly according to 
your current view options for the account. You will not be able to edit any account entries in 
this mode. 
 



Page Setup
Click on any are of the window you would like more information on: 
 

 
 



Header
Drag line to change margin at which the Header prints. 
 



Top
Drag line to change margin at which the Top of the printed data prints. 
 



Bottom
Drag line to change margin at which the Bottom of the printed data prints. 
 



Footer
Drag line to change margin at which the Footer prints. 
 



Left
Drag line to change left margin for printed data, headers and footers. 
 



Right
Drag line to change right margin for printed data, headers and footers. 
 



Displays the current margins in milimetres. 
 



Header Area
This is where the header will print. 
 



Body Area
This is where all the printed data will print. 
 



Footer Area
This where the footer will print. 
 



Page Orientation
Displays the way up on the page that data will print. 
This is governed by your default Printer Settings. 
 



Page Size
Displays the size of the printer page. 
This is governed by your current Printer Settings. 
 



Edit Categories
Click on any are of the window you would like more information on: 
 

 
 



Categories List
Categories in your database. 
Click on the category to edit it. 
 



Title
Edit the title for the currently selected category in this box. 
 



Keywords
Edit the keywords for the currently selected category in this box. 
Seperate keywords or phrases by exclamation marks (!). 
For example, if I wanted this category to respond to entries of ASDA, LITTLE SHOP and 
SAFEWAY then I could enter: 

ASDA!LITTLE SHOP!SAFEWAY 
 



New
Click here to add a new category to the database. 
 



Delete
Click here to delete the currently selected category. 
 



MDI
Multiple Document Interface 
 
Micawber allows a number of account months to be open at once. Each open month will be 
displayed in it's own window. 
The Window Menu allows you to control these windows. 
 



Clipboard
The windows clipboard provides a temporary space for storage of graphics and text. 
Many of the options on the Edit Menu allow you access to the clipboard. 
 
For example, if you wanted to move an account entry up in the account month, you could 
click on it to select it and then use the Cut option from the Edit menu followed by clicking on
the entry you would like to insert the entry above and selecting Paste Insert Above from the 
Edit menu. 
 



Payment Method
You can pay for your Micawber registration by the following methods: 
 

Cheque 
payable to Quintin Willison. 

 
Postal Order 

payable to Quintin Willison. 
 
Unfortunately, I cannot as yet accept credit cards. 
please do not send cash by post. 
 



Unlock Code
The personal unlock code contains your name encrypted as well as your serial number. 
Your unlock code is useless as to anyone else as it makes the Micawber program print your 
name around the program making it obvious that the other person is illegally using an 
unlcock code. 
 



Manual Registration
To register Micawber send a cheque or postal order made payable to 

QUINTIN WILLISON 
for 12 pounds at the following address: 

Quintin Willison    
Moose Productions    
The Old Rectory    
Norfolk    
NR16 1RW    
UK    

with a cover letter specifying your full name (including any first or middle names), the 
version of Micawber you are currently using, and how you would like to receive your unlock 
code. Chose from the following: 
1) First Class UK mainland address - including postcode. 
2) UK Phone Number. NOT a mobile or premium rate service. Specify the STD area code and

county. 
 



Mailing Option
You can recieve your Micawber unlock code by any of the following methods: 
 

Land Mail 
First class mail (UK and Ireland) 

 
Telephone 

To a land telephone number (NOT a mobile or premium rate number). 
 



Registration Form
Reached by clicking on the Registration Form option on the Help menu. 
 
Enter your details in the boxes on the form. 
 
Chose your preferred payment method and method of recieving the unlock code. 
 
Once you are ready, click on the Print... button and Lottery will print a letter addressed to 
Moose Productions for you with all the information in it. This letter will be printed to your 
default Windows printer. 
 
If you have any problems, or you do not have a printer, then write a manual registration. 
 



Register Micawber
Enter the unlock code which you have been sent. It is grouped into sets of four digits to 
make it easier to enter. 
 
If you do not yet have an unlock code then you will need to write to Moose Productions to 
register. 
 



MICAWBER.COD
For registered users, this holds your personal unlock code so that it is automatically entered 
for you every time the program loads. 
 



Working Directory
This is the directory that Micawber loads up with. 
Initialisation details and your unlock code file (MICAWBER.COD) are found here. 
 



Select Categories
Click on any are of the window you would like more information on: 
 

 
 



Selected Categories
Displays the categories which will be used by the filter. 
 
To remove a category from this list, select it and then click on the following button: 

 
 



Available Categories
Displays the categories which will not used by the filter. 
 
To add a category to those used by the filter, select it and click on the following: 

 
 



Add Category
Select a category from the Available Categories list and then click on this button to add it to 
the categories used by the Filter. 
 



Remove Category
Select a category from the Selected Categories list and then click on this button to remove it
from the categories used by the Filter. 
 



Coming Soon
Expect the following from future versions of Micawber: 
 
- More account analysis options. 
- Printing of analysis graphs. 
- Linking of account entries between accounts. 
- User maintainable formatting of amounts. 
- Possibly the ability to store more account entries per account month. 
- Password encoding for accounts data local to each base directory. 

 



Other Moose Productions
Lottery 
15 methods to select your Lottery numbers, including random numbers, hot/cold numbers, 
prose analysis, drawing pictures, join the dots, make your own pizza and much much more. 
Also stores a database of past draws, with lots of analysis options. 
Syndicate options for use in an office. 
Received a review score of 8 out of 10 in a PC home magazine article (December 1995) 
which is the same score as the offical Camelot endorsed software. 
 
HelpMake 
Fast and quick help file creation tool. 
Use with the Microsoft Help Compiler for DOS. 
Creates the RTF and HPJ files required by the Help Compiler and runs the compiler for you. 
MDI application allowing editing of many help topics at a time. 
 
Postit 
Windows postit notes with multimedia events. 
Allows you to set up reminder notes to trigger when you run an application. 
 
Sound FX 
Windows multimedia sound files manager - librarian, push player and sequencer. 
 
Fontlist 
Prints quick lists of available fonts to printer. 
 
For information on any of the above mentioned software contact the author. 
 



Invalid Unlock Code
Error-070001 
 
Problem: 
You entered an in-correct unlock into the Lottery program. 
 
Solution: 
Try checking through all the digits in the number you typed in to see whether any of them 
have been typed in in-correctly (you can scroll through it with the arrow keys). 
If you are positive that you have typed the number in correctly, and the number you have 
typed in was sent to you by Moose Productions then contact the author. Please have your 
serial number at hand if you phone, or include it in your mailing if sending an E-mail or 
letter. 
 



Account Information
The following information is displayed in this information window: 
 
Account Name 
The name of the account as you entered it when you created it. 
This is the name you see in the lists when you load accounts and whenever the account is 
referred to by Micawber. 
 
Information 
This is additional information as you entered it when you created the account. 
 
Current Month 
This is the currently loaded account month. 
 
Total Entries 
This is the number of accounting entries in the currently loaded account month. 
 
Opening Balance 
This is the opening balance of the currently loaded account month. 
 
Closing balance 
This the closing balance of the currently loaded account month. 
 
Total Payments 
This is the total amount of money that has gone out of the account in payments in the 
currently loaded account month. 
 
Total Receipts 
This is the total amount of money that has come into the account in receipts in the currently 
loaded account month. 
 



Account: Information...
Displays the Account Information window. 
 



Select Month
Click on any are of the window you would like more information on: 
 

 
 



Greyed out Month
This month is greyed out because you cannot select it. 
For example, if you are loading an account month, this could be either because the month is 
already loaded or because it does not exist. 
 



Month
Click on this button to select the month. 
 



Year Scroll
Use this to change the year from which you would like to select a month. 
 



Shows the year from which you are currently selected a month. 
Use the Scroll bar to change. 
 






